
Q .1Q .1 India  emerged as  one of the top s ix  c ountr ies  global ly  in fil ing patents  for  whic h upc oming tec hnology ,  as  s tated byIndia emerged as  one of the top s ix  c ountr ies  global ly  in fil ing patents  for  whic h upc oming tec hnology ,  as  s tated by
the Union M inis ter  of  S tate for  C ommunic at ions  and Rural  Development in M ay  2 0 2 5?the Union M inis ter  of  S tate for  C ommunic at ions  and Rural  Development in M ay  2 0 2 5?

A nsA ns 1. Quantum Computing technology

2. Artificial Intelligence (AI) technology

3. 5G technology

4. 6G technology

Q .2Q .2 The head of Judic iary  in a  s tate is  c al led  the _______ .The head of Judic iary  in a  s tate is  c al led  the _______ .

A nsA ns 1. Chief Justice of the High Court

2. Chief Minister

3. Governor

4. Attorney General

Q .3Q .3 Who among the fo l lowing propounded the idea of 'S uddhi ' ,  that  the indiv iduals  who had c onverted to  otherWho among the fo l lowing propounded the idea of 'S uddhi ' ,  that  the indiv iduals  who had c onverted to  other
rel igions ,  s hould  rec onvert  to  Hinduis m?rel igions ,  s hould  rec onvert  to  Hinduis m?

A nsA ns 1. Debendranath Tagore

2. Dayananda Saraswati

3. Gopal Ganesh Agarkar

4. Ramakrishna Paramahamsa

Q .4Q .4 O ut of the 1 3 1 9 reported mines  in Ind ia  (as  of  2 0 2 1 -2 2 ) ,  whic h s tate has  the highes t  number of mines?O ut of the 1 3 1 9 reported mines  in Ind ia  (as  of  2 0 2 1 -2 2 ) ,  whic h s tate has  the highes t  number of mines?

A nsA ns 1. West Bengal

2. Madhya Pradesh

3. Andhra Pradesh

4. Gujarat

Q . 5Q . 5 In O c tober  2 0 24 ,  after  the order  of S upreme C ourt ,  whic h of the fo l lowing s tates  has  s tarted the s ub- c las s ific at ionIn O c tober  2 0 24 ,  after  the order  of S upreme C ourt ,  whic h of the fo l lowing s tates  has  s tarted the s ub- c las s ific at ion
of s c heduled c as tes?of s c heduled c as tes?

A nsA ns 1. Kerala

2. Himachal Pradesh

3. Haryana

4. Punjab

Q .6Q .6 In the Third  C arnat ic  War,  the Br it is h E as t  Ind ia  C ompany  defeated the ________ forces  at  the Batt le of  Wandiwas h.In the Third  C arnat ic  War,  the Br it is h E as t  Ind ia  C ompany  defeated the ________ forces  at  the Batt le of  Wandiwas h.

A nsA ns 1. Portuguese

2. French

3. Dutch

4. Spanish
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Q .7Q .7 A cc ording to  A rt ic le 1 4 4  of the Indian C ons t itut ion,  a l l  author it ies ,  c iv i l  and judic ia l ,  in  the terr itory  of Ind ia  s hal lA cc ording to  A rt ic le 1 4 4  of the Indian C ons t itut ion,  a l l  author it ies ,  c iv i l  and judic ia l ,  in  the terr itory  of Ind ia  s hal l
ac t  in a id  of  the _____ .ac t  in a id  of  the _____ .

A nsA ns 1. Supreme Court of India

2. Prime Minister of India

3. Parliament

4. President of India

Q .8Q .8 Whic h of the fo l lowing s tatements  is  true about a l luv ia l  s o i ls  in Ind ia?Whic h of the fo l lowing s tatements  is  true about a l luv ia l  s o i ls  in Ind ia?

A nsA ns 1. Alluvial soils cover about 50% of the total area of the country and are mostly found in desert regions.

2. Alluvial soils are only found in the Ganga plains and not in the Brahmaputra valley.

3. Khadar represents new alluvium, deposited by floods annually, while Bhangar represents older alluvium deposited away
from flood plains.

4. Alluvial soils are rich in phosphorous but poor in potash.

Q .9Q .9 M os t of the r ivers  in Nagaland are tr ibutar ies  of  whic h major  r iver?M os t of the r ivers  in Nagaland are tr ibutar ies  of  whic h major  r iver?

A nsA ns 1. Yamuna

2. Ganges

3. Irrawaddy

4. Brahmaputra

Q .1 0Q .1 0 Whic h of the fo l lowing r ivers  fl ows  through the Thar  Des ert?Whic h of the fo l lowing r ivers  fl ows  through the Thar  Des ert?

A nsA ns 1. Luni

2. Tapi

3. Pennar

4. Kosi

Q .1 1Q .1 1 What is  the pr imary  purpos e of as k ing ques t ions  in the Par l iament?What is  the pr imary  purpos e of as k ing ques t ions  in the Par l iament?

A nsA ns 1. To gather information and ensure accountability

2. To express personal opinions

3. To criticise the Government

4. To delay proceedings

Q .1 2Q .1 2 Whic h among the fo l lowing was  the mas c ot of Khelo  India  Winter  G ames  2 0 24 ?Whic h among the fo l lowing was  the mas c ot of Khelo  India  Winter  G ames  2 0 24 ?

A nsA ns 1. 

2. 

3. 

4. 

Q .1 3Q .1 3 The G S T C ounc i l ,  res pons ible for  making rec ommendations  on G S T implementat ion in Ind ia ,  is  c ons t ituted underThe G S T C ounc i l ,  res pons ible for  making rec ommendations  on G S T implementat ion in Ind ia ,  is  c ons t ituted under
whic h A rt ic le of  the C ons t itut ion?whic h A rt ic le of  the C ons t itut ion?

A nsA ns 1. Article 301

2. Article 279-A

3. Article 280

4. Article 370
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Q .1 4Q .1 4 Whic h of the fo l lowing s oc ia l  reformers  was  NO T as s oc iated with the Brahmo S amaj?Whic h of the fo l lowing s oc ia l  reformers  was  NO T as s oc iated with the Brahmo S amaj?

A nsA ns 1. Atmaram Pandurang

2. Keshub Chandra Sen

3. Raja Ram Mohan Roy

4. Debendranath Tagore

Q .1 5Q .1 5 Whic h of the fo l lowing was  the forced labour  tax impos ed on the c ommon people by  the C hola dy nas ty  of TamilWhic h of the fo l lowing was  the forced labour  tax impos ed on the c ommon people by  the C hola dy nas ty  of Tamil
Nadu?Nadu?

A nsA ns 1. Vetti

2. Tari-irai

3. Panjupili

4. Ilani

Q .1 6Q .1 6 Who among the fo l lowing was  c onfirmed as  the new c hairman of the Internat ional  C r ic ket  C ounc i l  ( ICC ) ,  s et  toWho among the fo l lowing was  c onfirmed as  the new c hairman of the Internat ional  C r ic ket  C ounc i l  ( ICC ) ,  s et  to
begin his  term on 1  December 2 0 24 ?begin his  term on 1  December 2 0 24 ?

A nsA ns 1. Sourav Ganguly

2. Jay Shah

3. Greg Barclay

4. Shashank Manohar

Q .1 7Q .1 7 A cc ording to  the 2 0 1 1  C ens us  of Ind ia ,  whic h rel igion is  largely  fo l lowed in M izoram?A cc ording to  the 2 0 1 1  C ens us  of Ind ia ,  whic h rel igion is  largely  fo l lowed in M izoram?

A nsA ns 1. Islam

2. Hinduism

3. Sikhism

4. Christianity

Q .1 8Q .1 8 A s  of O c tober  2 0 24 ,  what is  repay ment per iod under  ‘V iras at  S c heme’ of  Nat ional  M inor it ies  Development andA s  of O c tober  2 0 24 ,  what is  repay ment per iod under  ‘V iras at  S c heme’ of  Nat ional  M inor it ies  Development and
Finance C orporat ion ( NM DFC ) ?Finance C orporat ion ( NM DFC ) ?

A nsA ns 1. 5 years

2. 4 years

3. 2 years

4. 3 years

Q .1 9Q .1 9 Whic h s ummit d id  Pr ime M inis ter  Narendra M odi  des c r ibe as  an init iat ive that  wi l l  ' s tay ,  as s is t ,  partner,  andWhic h s ummit d id  Pr ime M inis ter  Narendra M odi  des c r ibe as  an init iat ive that  wi l l  ' s tay ,  as s is t ,  partner,  and
c omplement '?c omplement '?

A nsA ns 1. BRICS Summit 2024

2. ASEAN Summit 2024

3. QUAD Summit 2024

4. G20 Summit 2024

Q .2 0Q .2 0 With reference to  M edieval  his tory ,  who were Das want and Bas awan?With reference to  M edieval  his tory ,  who were Das want and Bas awan?

A nsA ns 1. 

2. 

3. 

4. 
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Q .2 1Q .2 1 If  2  is  added to  eac h odd d igit  and 3  is  s ubtrac ted from eac h even d igit  in the number 3 4 5781 6 ,  then what wi l l  theIf  2  is  added to  eac h odd d igit  and 3  is  s ubtrac ted from eac h even d igit  in the number 3 4 5781 6 ,  then what wi l l  the
s um of the d igits  whic h are third  from the left  and third  from the r ight  in the new number thus  formed be?s um of the d igits  whic h are third  from the left  and third  from the r ight  in the new number thus  formed be?

A nsA ns 1. 16

2. 18

3. 14

4. 12

Q .2 2Q .2 2 E ac h vowel  in the word WIRE L E S S  is  c hanged to  the letter  immediately  fo l lowing it  in the E ngl is h a lphabetic alE ac h vowel  in the word WIRE L E S S  is  c hanged to  the letter  immediately  fo l lowing it  in the E ngl is h a lphabetic al
order  and eac h c ons onant is  c hanged to  the letter  immediately  preceding it  in the E ngl is h a lphabetic al  order.order  and eac h c ons onant is  c hanged to  the letter  immediately  preceding it  in the E ngl is h a lphabetic al  order.
Whic h of the fo l lowing letters  wi l l  be third  from the r ight  in the group of letters  thus  formed?Whic h of the fo l lowing letters  wi l l  be third  from the r ight  in the group of letters  thus  formed?

A nsA ns 1. F

2. V

3. J

4. R

Q .2 3Q .2 3 What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?

743  743  70 4  70 4  665 665 62 6 62 6 ??

A nsA ns 1. 

2. 

3. 

4. 

Q .24Q .24 If  1  is  added to  eac h odd d igit  and 2  is  s ubtrac ted from eac h even d igit  in the number 2 784 561 7,  what wi l l  be theIf  1  is  added to  eac h odd d igit  and 2  is  s ubtrac ted from eac h even d igit  in the number 2 784 561 7,  what wi l l  be the
s um of the d igits  that  are third  from the left  and s ec ond from the r ight?s um of the d igits  that  are third  from the left  and s ec ond from the r ight?

A nsA ns 1. 7

2. 5

3. 8

4. 6

Q .2 5Q .2 5 S elec t  the c orrec t  mirror  image of the given c ombinat ion when the mirror  is  placed at  'M N'  as  s hown below.S elec t  the c orrec t  mirror  image of the given c ombinat ion when the mirror  is  placed at  'M N'  as  s hown below.

A nsA ns 1. 

2. 

3. 

4. 

Q .2 6Q .2 6 A l l  3 0  s tudents  in a  c las s  are s tanding in a  row fac ing north.  Roopa is  1 5A l l  3 0  s tudents  in a  c las s  are s tanding in a  row fac ing north.  Roopa is  1 5t ht h  from the r ight  end whi le A nand is  1 0 from the r ight  end whi le A nand is  1 0t ht h

from the left  end .  How many  people s tand between Roopa and A nand?from the left  end .  How many  people s tand between Roopa and A nand?

A nsA ns 1. 3

2. 6

3. 4

4. 5
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Q .2 7Q .2 7 S ix  people,  G ,  H ,  I ,  J ,  S  and T,  are s itt ing around a c irc ular  table,  fac ing the centre of the table.  I  s its  to  theS ix  people,  G ,  H ,  I ,  J ,  S  and T,  are s itt ing around a c irc ular  table,  fac ing the centre of the table.  I  s its  to  the
immediate r ight  of H .  G  s its  s ec ond to  the r ight  of of  H .  O nly  three people s it  between I  and T  when c ounted fromimmediate r ight  of H .  G  s its  s ec ond to  the r ight  of of  H .  O nly  three people s it  between I  and T  when c ounted from
the left  of  I .  J  s its  to  the immediate r ight  of S.  How many  people s it  between G  and S  when c ounted from the left  ofthe left  of  I .  J  s its  to  the immediate r ight  of S.  How many  people s it  between G  and S  when c ounted from the left  of
S ?S ?

A nsA ns 1. Three

2. Two

3. None

4. One

Q .2 8Q .2 8 C WHG  is  related to  ZV E F in a  certain way  bas ed on the E ngl is h a lphabetic al  order.  In the s ame way ,  Q A ZT is  relatedC WHG  is  related to  ZV E F in a  certain way  bas ed on the E ngl is h a lphabetic al  order.  In the s ame way ,  Q A ZT is  related
to NZWS.  To whic h of the given options  is  PDV F related ,  fo l lowing the s ame logic ?to  NZWS.  To whic h of the given options  is  PDV F related ,  fo l lowing the s ame logic ?

A nsA ns 1. NDUD

2. MCSE

3. ODTF

4. NCUG

Q .2 9Q .2 9 Three of the fo l lowing pairs  of  words  are a l ike in a  certain way  and thus  form a group.  Whic h word- pair  DO E S  NO TThree of the fo l lowing pairs  of  words  are a l ike in a  certain way  and thus  form a group.  Whic h word- pair  DO E S  NO T
belong to  that  group?belong to  that  group?

A nsA ns 1. Sculptor - Chisel

2. Blacksmith - Anvil

3. Farmer - Screwdriver

4. Tailor - Needle

Q .3 0Q .3 0 Two s ets  of  numbers  are given below.  In eac h s et  of  numbers ,  certain mathematic al  operat ion(s)  on the firs tTwo s ets  of  numbers  are given below.  In eac h s et  of  numbers ,  certain mathematic al  operat ion(s)  on the firs t
number res ults  in the s ec ond number.  S imilar ly ,  certain mathematic al  operat ion(s)  on the s ec ond number res ults  innumber res ults  in the s ec ond number.  S imilar ly ,  certain mathematic al  operat ion(s)  on the s ec ond number res ults  in
the third  number and s o  on.  Whic h of the given options  fo l lows  the s ame s et  of  operat ions  as  in the given s ets?  the third  number and s o  on.  Whic h of the given options  fo l lows  the s ame s et  of  operat ions  as  in the given s ets?  

( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing down the numbers  into  their( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing down the numbers  into  their
c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc h as  adding /  s ubtrac t ing /mult iply ing to  1 3  c an be performed.c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc h as  adding /  s ubtrac t ing /mult iply ing to  1 3  c an be performed.
Break ing down 1 3  into  1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  not  a l lowed . )  Break ing down 1 3  into  1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  not  a l lowed . )  

6  – 9  – 5 – 2 5;  6  – 9  – 5 – 2 5;  1 1  – 1 4  – 1 0  – 501 1  – 1 4  – 1 0  – 50

A nsA ns 1. 15 – 17 – 20 – 80

2. 16 – 19 – 15 – 75

3. 18 – 21 – 24 – 120

4. 11 – 13 – 18 – 90

Q .3 1Q .3 1 If  a l l  the letters  of  the word PO L IT IC A L  are rearranged acc ording to  the E ngl is h a lphabetic al  order,  then how manyIf  a l l  the letters  of  the word PO L IT IC A L  are rearranged acc ording to  the E ngl is h a lphabetic al  order,  then how many
letters  wi l l  retain their  or iginal  pos it ion(s) ?letters  wi l l  retain their  or iginal  pos it ion(s) ?

A nsA ns 1. Three

2. Two

3. One

4. Zero

Q .3 2Q .3 2 C D 1 7  is  related to  HI  2 3  in a  certain way .  In the s ame way ,  KL  3 5 is  related to  PQ  4 1 .  To  whic h of the given optionsC D 1 7  is  related to  HI  2 3  in a  certain way .  In the s ame way ,  KL  3 5 is  related to  PQ  4 1 .  To  whic h of the given options
is  S T  53  related ,  fo l lowing the s ame logic ?is  S T  53  related ,  fo l lowing the s ame logic ?

A nsA ns 1. VW 47

2. YZ 59

3. XY 59

4. WX 47
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Q .3 3Q .3 3 E ac h vowel  in the word UNIV E RS E  is  c hanged to  the letter  immediately  fo l lowing it  in the E ngl is h a lphabetic alE ac h vowel  in the word UNIV E RS E  is  c hanged to  the letter  immediately  fo l lowing it  in the E ngl is h a lphabetic al
order  and eac h c ons onant is  c hanged to  the letter  immediately  order  and eac h c ons onant is  c hanged to  the letter  immediately  preceding it  in the E ngl is h a lphabetic al  order.  A l lpreceding it  in the E ngl is h a lphabetic al  order.  A l l
the letters  thus  formed are then arranged in the alphabetic al  order.  Whic h of the fo l lowing letters  wi l l  appear  onthe letters  thus  formed are then arranged in the alphabetic al  order.  Whic h of the fo l lowing letters  wi l l  appear  on
s ec ond pos it ion from r ight in the new letter- c lus ter  thus  formed?s ec ond pos it ion from r ight in the new letter- c lus ter  thus  formed?

A nsA ns 1. J

2. U

3. F

4. R

Q .3 4Q .3 4 If  ‘A’ s tands  for  ‘÷ ’ ,  ‘B ’ s tands  for  ‘× ’ ,  ‘C ’ s tands  for  ‘+ ’ and ‘D ’ s tands  for  ‘ - ’ ,  what wi l l  c ome in place of the ques t ionIf  ‘A’ s tands  for  ‘÷ ’ ,  ‘B ’ s tands  for  ‘× ’ ,  ‘C ’ s tands  for  ‘+ ’ and ‘D ’ s tands  for  ‘ - ’ ,  what wi l l  c ome in place of the ques t ion
mark  ( ? )  in the fo l lowing equation?mark  ( ? )  in the fo l lowing equation?
84  A  4  B  9  C  5 D  4  = ?84  A  4  B  9  C  5 D  4  = ?

A nsA ns 1. 178

2. 189

3. 190

4. 191

Q .3 5Q .3 5 What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?

3 4  3 4  61  61  88 88 1 1 5 1 1 5 ?  ?  1 691 69

A nsA ns 1. 139

2. 142

3. 137

4. 146

Q .3 6Q .3 6 E ac h letter  in the word LO NG HA IRS  is  c hanged to  the letter  immediately  preceding it  in the E ngl is h a lphabetic alE ac h letter  in the word LO NG HA IRS  is  c hanged to  the letter  immediately  preceding it  in the E ngl is h a lphabetic al
order  and then al l  the letters  thus  formed are arranged in the E ngl is h a lphabetic al  order.  Whic h of the fo l lowingorder  and then al l  the letters  thus  formed are arranged in the E ngl is h a lphabetic al  order.  Whic h of the fo l lowing
letters  wi l l  be s ec ond from the r ight  in the new group of letters  thus  formed?letters  wi l l  be s ec ond from the r ight  in the new group of letters  thus  formed?

A nsA ns 1. H

2. G

3. Q

4. R

Q .3 7Q .3 7 Bas ed on the E ngl is h a lphabetic al  order,  three of the fo l lowing four  letter- c lus ters  are a l ike in a  certain way  andBas ed on the E ngl is h a lphabetic al  order,  three of the fo l lowing four  letter- c lus ters  are a l ike in a  certain way  and
thus  form a group.  Whic h letter- c lus ter  DO E S  NO T belong to  that  group?  ( Note:  The odd one out is  not  bas ed onthus  form a group.  Whic h letter- c lus ter  DO E S  NO T belong to  that  group?  ( Note:  The odd one out is  not  bas ed on
the number of c ons onants/vowels  or  their  pos it ion in the letter- c lus ter. )the number of c ons onants/vowels  or  their  pos it ion in the letter- c lus ter. )

A nsA ns 1. SOR

2. OLP

3. GDH

4. WTX

Q .3 8Q .3 8 S elec t  the pair  that  fo l lows  the s ame pattern as  that  fo l lowed by  the two pairs  given below.  Both pairs  fo l low theS elec t  the pair  that  fo l lows  the s ame pattern as  that  fo l lowed by  the two pairs  given below.  Both pairs  fo l low the
s ame pattern.  s ame pattern.  

V L L  :  WNHV L L  :  WNH
NKI :  O M ENKI :  O M E

A nsA ns 1. COP : DQK

2. DLI :  EME

3. INK : JPF

4. WFR : XHN
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Q .3 9Q .3 9

A nsA ns 1. 

2. 

3. 

4. 

Q .4 0Q .4 0 S elec t  the s et  in whic h the numbers  are related in the s ame way  as  are the numbers  of the fo l lowing s ets .  S elec t  the s et  in whic h the numbers  are related in the s ame way  as  are the numbers  of the fo l lowing s ets .  
( Note:  O perat ions  s hould  be performed on the whole numbers ,  without break ing down the numbers  into  their( Note:  O perat ions  s hould  be performed on the whole numbers ,  without break ing down the numbers  into  their
c ons t ituent d igits .  E .g . ,  1 3  – O perat ions  on 1 3  s uc h as  adding/s ubtrac t ing/mult iply ing to  1 3  c an be performed.c ons t ituent d igits .  E .g . ,  1 3  – O perat ions  on 1 3  s uc h as  adding/s ubtrac t ing/mult iply ing to  1 3  c an be performed.
Break ing down 1 3  into  1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  not  a l lowed . )  Break ing down 1 3  into  1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  not  a l lowed . )  

( 9 ,  81 ,  3 )( 9 ,  81 ,  3 )
( 6 ,  54 ,  2 )( 6 ,  54 ,  2 )

A nsA ns 1. (10, 90, 3)

2. (5, 45, 1)

3. (8, 64, 2)

4. (12, 108, 4)

Q .4 1Q .4 1 S elec t  the mos t appropr iate option to  fil l  in the blank .S elec t  the mos t appropr iate option to  fil l  in the blank .
This  is  the gir l  ___  won the pr ize.This  is  the gir l  ___  won the pr ize.

A nsA ns 1. whom

2. whose

3. who

4. which

Q .4 2Q .4 2 S elec t  the mos t appropr iate A NTO NYM  of the given word .S elec t  the mos t appropr iate A NTO NYM  of the given word .

Doc i leDoc i le

A nsA ns 1. Submissive

2. Tractable

3. Defiant

4. Obedient

Q .43Q .43 S elec t  the mos t appropr iate option to  fil l  in the blank .S elec t  the mos t appropr iate option to  fil l  in the blank .
___ y ou c omplete y our  homework ,  y ou c an watc h TV.___ y ou c omplete y our  homework ,  y ou c an watc h TV.

A nsA ns 1. If

2. Unless

3. Though

4. Still

Section : General English and Comprehension
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Q .4 4Q .4 4 S elec t  the mos t appropr iate meaning of the given phras e.S elec t  the mos t appropr iate meaning of the given phras e.

To read the r iot  ac tTo read the r iot  ac t

A nsA ns 1. To ignore someone deliberately

2. To issue a public statement

3. To create a disturbance

4. To sternly warn someone

Q .4 5Q .4 5 S elec t  the option that  c an be us ed as  a  one- word s ubs t itute for  the under l ined group of words .S elec t  the option that  c an be us ed as  a  one- word s ubs t itute for  the under l ined group of words .

E mpowering women involves  ac quir ing talent  and E mpowering women involves  ac quir ing talent  and keeping in pos s es s ion or  us ingkeeping in pos s es s ion or  us ing talent  by  having the r ight talent  by  having the r ight
environment where they  c an be promoted and thr ive.environment where they  c an be promoted and thr ive.

A nsA ns 1. retaining

2. acclimating

3. updating

4. fluctuating

C omprehens ion:C omprehens ion:

Read the given passage carefully and answer the questions that follow.

Modern environmentalism, once rooted in conservation and wilderness preservation, has evolved into a complex global
movement confronting climate change, economic inequality, and indigenous rights. Its goals are no longer confined to saving
endangered species or protecting remote ecosystems; rather, it now addresses how resource exploitation disproportionately
affects marginalised populations. Critics argue that environmental advocacy sometimes ignores socioeconomic realities,
imposing blanket solutions that disregard local contexts. Yet increasingly, grassroots leaders—especially from the Global South
—are reshaping the conversation, emphasising environmental justice over abstract preservation. This paradigm shift
underscores the need for inclusive frameworks that integrate ecological integrity with social equity. Activism today must
confront power imbalances within global capitalism, where pollution and exploitation are outsourced to vulnerable regions. The
green future cannot be envisioned without grappling with historical injustices. Thus, environmentalism’s trajectory is no longer
merely ecological—it is political, ethical, and intersectional, demanding redefinition in light of interconnected planetary and
human crises.

S ubQ ues t ion No :  4 6S ubQ ues t ion No :  4 6

Q .4 6Q .4 6 How is  the s truc ture of the pas s age bes t  des c r ibed?How is  the s truc ture of the pas s age bes t  des c r ibed?

A nsA ns 1. Question-answer format: exploring doubts about activism

2. Comparison: contrasting Global North and South approaches

3. Historical progression: from past to present-day environmentalism

4. Narrative: telling the story of a single activist
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C omprehens ion:C omprehens ion:

Read the given passage carefully and answer the questions that follow.

Modern environmentalism, once rooted in conservation and wilderness preservation, has evolved into a complex global
movement confronting climate change, economic inequality, and indigenous rights. Its goals are no longer confined to saving
endangered species or protecting remote ecosystems; rather, it now addresses how resource exploitation disproportionately
affects marginalised populations. Critics argue that environmental advocacy sometimes ignores socioeconomic realities,
imposing blanket solutions that disregard local contexts. Yet increasingly, grassroots leaders—especially from the Global South
—are reshaping the conversation, emphasising environmental justice over abstract preservation. This paradigm shift
underscores the need for inclusive frameworks that integrate ecological integrity with social equity. Activism today must
confront power imbalances within global capitalism, where pollution and exploitation are outsourced to vulnerable regions. The
green future cannot be envisioned without grappling with historical injustices. Thus, environmentalism’s trajectory is no longer
merely ecological—it is political, ethical, and intersectional, demanding redefinition in light of interconnected planetary and
human crises.

S ubQ ues t ion No :  47S ubQ ues t ion No :  47

Q .47Q .47 What is  the tone of the pas s age?What is  the tone of the pas s age?

A nsA ns 1. Celebratory and enthusiastic

2. Critical and dismissive

3. Humorous and skeptical

4. Reflective and assertive

C omprehens ion:C omprehens ion:

Read the given passage carefully and answer the questions that follow.

Modern environmentalism, once rooted in conservation and wilderness preservation, has evolved into a complex global
movement confronting climate change, economic inequality, and indigenous rights. Its goals are no longer confined to saving
endangered species or protecting remote ecosystems; rather, it now addresses how resource exploitation disproportionately
affects marginalised populations. Critics argue that environmental advocacy sometimes ignores socioeconomic realities,
imposing blanket solutions that disregard local contexts. Yet increasingly, grassroots leaders—especially from the Global South
—are reshaping the conversation, emphasising environmental justice over abstract preservation. This paradigm shift
underscores the need for inclusive frameworks that integrate ecological integrity with social equity. Activism today must
confront power imbalances within global capitalism, where pollution and exploitation are outsourced to vulnerable regions. The
green future cannot be envisioned without grappling with historical injustices. Thus, environmentalism’s trajectory is no longer
merely ecological—it is political, ethical, and intersectional, demanding redefinition in light of interconnected planetary and
human crises.

S ubQ ues t ion No :  4 8S ubQ ues t ion No :  4 8

Q .4 8Q .4 8 What is  the bes t  s ummary  of the pas s age?What is  the bes t  s ummary  of the pas s age?

A nsA ns 1. The passage describes how environmentalism should ignore politics.

2. Environmental movements have become global political efforts focused on justice and equity.

3. Environmental activism must return to traditional conservation ideals.

4. Environmentalism is now about saving endangered species through policy.
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C omprehens ion:C omprehens ion:

Read the given passage carefully and answer the questions that follow.

Modern environmentalism, once rooted in conservation and wilderness preservation, has evolved into a complex global
movement confronting climate change, economic inequality, and indigenous rights. Its goals are no longer confined to saving
endangered species or protecting remote ecosystems; rather, it now addresses how resource exploitation disproportionately
affects marginalised populations. Critics argue that environmental advocacy sometimes ignores socioeconomic realities,
imposing blanket solutions that disregard local contexts. Yet increasingly, grassroots leaders—especially from the Global South
—are reshaping the conversation, emphasising environmental justice over abstract preservation. This paradigm shift
underscores the need for inclusive frameworks that integrate ecological integrity with social equity. Activism today must
confront power imbalances within global capitalism, where pollution and exploitation are outsourced to vulnerable regions. The
green future cannot be envisioned without grappling with historical injustices. Thus, environmentalism’s trajectory is no longer
merely ecological—it is political, ethical, and intersectional, demanding redefinition in light of interconnected planetary and
human crises.

S ubQ ues t ion No :  4 9S ubQ ues t ion No :  4 9

Q .4 9Q .4 9 How does  the pas s age c onnec t  to  real- wor ld  is s ues?How does  the pas s age c onnec t  to  real- wor ld  is s ues?

A nsA ns 1. It criticises activists from the Global South.

2. It discusses policy recommendations in the current UN climate reports.

3. It focuses on theoretical environmental models with no application.

4. It addresses ongoing debates about environmental justice and global inequality.

C omprehens ion:C omprehens ion:

Read the given passage carefully and answer the questions that follow.

Modern environmentalism, once rooted in conservation and wilderness preservation, has evolved into a complex global
movement confronting climate change, economic inequality, and indigenous rights. Its goals are no longer confined to saving
endangered species or protecting remote ecosystems; rather, it now addresses how resource exploitation disproportionately
affects marginalised populations. Critics argue that environmental advocacy sometimes ignores socioeconomic realities,
imposing blanket solutions that disregard local contexts. Yet increasingly, grassroots leaders—especially from the Global South
—are reshaping the conversation, emphasising environmental justice over abstract preservation. This paradigm shift
underscores the need for inclusive frameworks that integrate ecological integrity with social equity. Activism today must
confront power imbalances within global capitalism, where pollution and exploitation are outsourced to vulnerable regions. The
green future cannot be envisioned without grappling with historical injustices. Thus, environmentalism’s trajectory is no longer
merely ecological—it is political, ethical, and intersectional, demanding redefinition in light of interconnected planetary and
human crises.

S ubQ ues t ion No :  50S ubQ ues t ion No :  50

Q . 50Q . 50 What is  the central  theme of the pas s age?What is  the central  theme of the pas s age?

A nsA ns 1. Environmentalism is too idealistic to handle real-world issues.

2. The environment cannot be saved without economic development.

3. Contemporary environmentalism must include justice, equity, and global inclusivity.

4. Indigenous rights are more important than climate concerns.

Q . 51Q . 51 WनYZल\ख तWनYZल\ख त   वा aवा a   कोको   उ eचतउ eचत   का र कका र क   hा राhा रा   प ूणlप ूणl   क रmक रm ।।
नंpद नीनंpद नी   र Wवर Wव   केके   फू फाफूफा  ___  ___  भv जीभv जी   हैहै ।।

A nsA ns 1. से

2. क{

3. से

4. का

Section : General Hindi and Comprehension
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Q . 52Q . 52 नी चेनी चे   pद एpद ए   अथlअथl   केके   ZलएZलए   उ प यु�उ प यु�   लो को ��लो को ��   pद एpद ए   ग एग ए   Wवक ��Wवक ��   मmमm   सेसे   चुWनएचुWनए । । 
WबनाWबना   सा मा नसा मा न   केके   का मका म   नह�नह�   हो ताहो ता

A nsA ns 1. तेल देखो तेल क{ धार देखो

2. तेल न Wमठाई, चू�े धर� कड़ाही

3. तेली के बैल को घर ही पचास कोस

4. तेल Wतल� से ही Wनकलता है।

Q . 53Q . 53 '' जैसेजैसे   ना ग ना थना ग ना थ   वैसेवैसे   स� प ना थस� प ना थ '  '  लो को ��लो को ��   काका   अथlअथl   aाaा   हैहै --

A nsA ns 1. दु�ता मm रावण जैसा �वहार करना

2. जैसा नाम वैसा काम

3. अवसरवादी होना

4. दु�ता मm दो ���य� का समान होना

Q . 54Q . 54 '' नी �जतानी �जता '  '  काका   Wवलो मWवलो म   हैहै --

A nsA ns 1. नीरवता

2. नीरसता

3. ��ता

4. Wनमlलता

Q . 55Q . 55 ’’ न�न� ’ ’ काका   Wवलो मWवलो म   श�श�   हो गाहो गा --

A nsA ns 1. नम

2. नाम

3. �वन�

4. अन�

C omprehens ion:C omprehens ion:

pदए गए ग�vश के आधार पर WनYZल\खत ��� के उ�र दीZजए।
भारत मm एक समय बौ� धम� का �ापक �सार हुआ था िक¡ु वैpदक pह¢ ूधमl के पुन�£ान के साथ अपनी ज¤भूWम मm इसक{ पकड़ ख़§ हो गयी और यह केवल
कुछ ªान� मm ही सीWमत रह गया। डॉ . अ­ेडकर ने इसे पुन�®ीWवत िकया य�िप उनके अनुयायी, Zजनमm से अ¯धकतर महार जाWत के थे, अपनी °ªWत सुधारने क{
pदशा मm अ¯धक कुछ नह� कर पाए। इ±m नव बौ� कहा जाता है। नव बौ�� क{ जाWतयv eछपी नह� ह²। भारत मm बौ� धमl पारंप³रक चार ´र� मm बटm  वणl Wवभाजन क{
तरह न होकर ph´र�य संरचना है। उपर� ´र पर ¶ा·ण और गृहपWतय� क{ कुछ ¹ेºणयv ªािपत ह² और Wनचले ´र मm जनजाWतय� तथा अ» सीमvत समूह ह²। बौ�
धमl का महायान और हीनयान मm Wवभाजन सैधvWतक मतभेद� पर आधा³रत था पर¡ु यह Wवभाजन समाज मm पद¼म का �WतWन¯धत½ नह� करता।

S ubQ ues t ion No :  56S ubQ ues t ion No :  56

Q . 56Q . 56 ग �v शग �v श   मmमm   � यु�� यु�  ' ' �ा प क�ा प क '  '  काका   Wवलो मWवलो म   श�श�   हो गाहो गा  - -

A nsA ns 1. अ�ा¾

2. अ�ापक

3. अ�ा¿

4. अ�´
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C omprehens ion:C omprehens ion:

pदए गए ग�vश के आधार पर WनYZल\खत ��� के उ�र दीZजए।
भारत मm एक समय बौ� धम� का �ापक �सार हुआ था िक¡ु वैpदक pह¢ ूधमl के पुन�£ान के साथ अपनी ज¤भूWम मm इसक{ पकड़ ख़§ हो गयी और यह केवल
कुछ ªान� मm ही सीWमत रह गया। डॉ . अ­ेडकर ने इसे पुन�®ीWवत िकया य�िप उनके अनुयायी, Zजनमm से अ¯धकतर महार जाWत के थे, अपनी °ªWत सुधारने क{
pदशा मm अ¯धक कुछ नह� कर पाए। इ±m नव बौ� कहा जाता है। नव बौ�� क{ जाWतयv eछपी नह� ह²। भारत मm बौ� धमl पारंप³रक चार ´र� मm बटm  वणl Wवभाजन क{
तरह न होकर ph´र�य संरचना है। उपर� ´र पर ¶ा·ण और गृहपWतय� क{ कुछ ¹ेºणयv ªािपत ह² और Wनचले ´र मm जनजाWतय� तथा अ» सीमvत समूह ह²। बौ�
धमl का महायान और हीनयान मm Wवभाजन सैधvWतक मतभेद� पर आधा³रत था पर¡ु यह Wवभाजन समाज मm पद¼म का �WतWन¯धत½ नह� करता।

S ubQ ues t ion No :  57S ubQ ues t ion No :  57

Q . 57Q . 57 भा र तभा र त   मmमm   बौ �बौ �   धमlधमl   क{क{   संर चनासंर चना   कै सीकै सी   हैहै  ? ?

A nsA ns 1. ph´र�य

2. सÀदायवादी

3. Wवभाजनकार�

4. चार वणÁ वाली

C omprehens ion:C omprehens ion:

pदए गए ग�vश के आधार पर WनYZल\खत ��� के उ�र दीZजए।
भारत मm एक समय बौ� धम� का �ापक �सार हुआ था िक¡ु वैpदक pह¢ ूधमl के पुन�£ान के साथ अपनी ज¤भूWम मm इसक{ पकड़ ख़§ हो गयी और यह केवल
कुछ ªान� मm ही सीWमत रह गया। डॉ . अ­ेडकर ने इसे पुन�®ीWवत िकया य�िप उनके अनुयायी, Zजनमm से अ¯धकतर महार जाWत के थे, अपनी °ªWत सुधारने क{
pदशा मm अ¯धक कुछ नह� कर पाए। इ±m नव बौ� कहा जाता है। नव बौ�� क{ जाWतयv eछपी नह� ह²। भारत मm बौ� धमl पारंप³रक चार ´र� मm बटm  वणl Wवभाजन क{
तरह न होकर ph´र�य संरचना है। उपर� ´र पर ¶ा·ण और गृहपWतय� क{ कुछ ¹ेºणयv ªािपत ह² और Wनचले ´र मm जनजाWतय� तथा अ» सीमvत समूह ह²। बौ�
धमl का महायान और हीनयान मm Wवभाजन सैधvWतक मतभेद� पर आधा³रत था पर¡ु यह Wवभाजन समाज मm पद¼म का �WतWन¯धत½ नह� करता।

S ubQ ues t ion No :  58S ubQ ues t ion No :  58

Q . 58Q . 58 ग �v शग �v श   मmमm   � यु�� यु�  ' ' प ुन�®ी Wवतपुन�®ी Wवत '  '  श�श�   काका   अथlअथl   हो गाहो गा  - -

A nsA ns 1. एक बार कही हुई बात िफर कहना।

2. िफर से लौटकर आना।

3. Zजसे िफर से जीWवत िकया गया हो ।

4. दोबारा िकया जाने वाला गठन।

C omprehens ion:C omprehens ion:

pदए गए ग�vश के आधार पर WनYZल\खत ��� के उ�र दीZजए।
भारत मm एक समय बौ� धम� का �ापक �सार हुआ था िक¡ु वैpदक pह¢ ूधमl के पुन�£ान के साथ अपनी ज¤भूWम मm इसक{ पकड़ ख़§ हो गयी और यह केवल
कुछ ªान� मm ही सीWमत रह गया। डॉ . अ­ेडकर ने इसे पुन�®ीWवत िकया य�िप उनके अनुयायी, Zजनमm से अ¯धकतर महार जाWत के थे, अपनी °ªWत सुधारने क{
pदशा मm अ¯धक कुछ नह� कर पाए। इ±m नव बौ� कहा जाता है। नव बौ�� क{ जाWतयv eछपी नह� ह²। भारत मm बौ� धमl पारंप³रक चार ´र� मm बटm  वणl Wवभाजन क{
तरह न होकर ph´र�य संरचना है। उपर� ´र पर ¶ा·ण और गृहपWतय� क{ कुछ ¹ेºणयv ªािपत ह² और Wनचले ´र मm जनजाWतय� तथा अ» सीमvत समूह ह²। बौ�
धमl का महायान और हीनयान मm Wवभाजन सैधvWतक मतभेद� पर आधा³रत था पर¡ु यह Wवभाजन समाज मm पद¼म का �WतWन¯धत½ नह� करता।

S ubQ ues t ion No :  59S ubQ ues t ion No :  59

Q . 59Q . 59 बौ �बौ �   धमlधमl   कोको   िक सनेिक सने   प ुन�®ी Wवतपुन�®ी Wवत   िक यािक या  ? ?

A nsA ns 1. महा§ा गvधी

2. डॉ . अ­ेडकर

3. ÂोWतबा फुले

4. ललई यादव
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C omprehens ion:C omprehens ion:

pदए गए ग�vश के आधार पर WनYZल\खत ��� के उ�र दीZजए।
भारत मm एक समय बौ� धम� का �ापक �सार हुआ था िक¡ु वैpदक pह¢ ूधमl के पुन�£ान के साथ अपनी ज¤भूWम मm इसक{ पकड़ ख़§ हो गयी और यह केवल
कुछ ªान� मm ही सीWमत रह गया। डॉ . अ­ेडकर ने इसे पुन�®ीWवत िकया य�िप उनके अनुयायी, Zजनमm से अ¯धकतर महार जाWत के थे, अपनी °ªWत सुधारने क{
pदशा मm अ¯धक कुछ नह� कर पाए। इ±m नव बौ� कहा जाता है। नव बौ�� क{ जाWतयv eछपी नह� ह²। भारत मm बौ� धमl पारंप³रक चार ´र� मm बटm  वणl Wवभाजन क{
तरह न होकर ph´र�य संरचना है। उपर� ´र पर ¶ा·ण और गृहपWतय� क{ कुछ ¹ेºणयv ªािपत ह² और Wनचले ´र मm जनजाWतय� तथा अ» सीमvत समूह ह²। बौ�
धमl का महायान और हीनयान मm Wवभाजन सैधvWतक मतभेद� पर आधा³रत था पर¡ु यह Wवभाजन समाज मm पद¼म का �WतWन¯धत½ नह� करता।

S ubQ ues t ion No :  60S ubQ ues t ion No :  60

Q .60Q .60 pद एpद ए   ग एग ए   ग �v शग �v श   केके   ZलएZलए   उ प यु�उ प यु�   शी ष lकशी षlक   हो गाहो गा  - -

A nsA ns 1. pह¢ ूधमl

2. भारत मm बौ� धमl

3. वणl Wवभाजन

4. वैpदक धमl

Q .61Q .61 What happens  to  an email  after  y ou c l ic k  the ‘S end ’ button?What happens  to  an email  after  y ou c l ic k  the ‘S end ’ button?

A nsA ns 1. It is saved in drafts.

2. It gets deleted.

3. It remains in the Outbox.

4. It is sent to the recipient’s email server.

Q .62Q .62 Whic h file ty pe C A NNO T be opened in M S  E xcel  2 0 2 1 ?Whic h file ty pe C A NNO T be opened in M S  E xcel  2 0 2 1 ?

A nsA ns 1. .xls

2. .xlsx

3. .excel

4. .csv

Q .63Q .63 Whic h of the fo l lowing is  the mos t effec t ive way  to  protec t  y our  s martphone from malware?Whic h of the fo l lowing is  the mos t effec t ive way  to  protec t  y our  s martphone from malware?

A nsA ns 1. Install a mobile security app

2. Only download apps from trusted sources

3. Keep your operating system and apps up to date

4. Use a strong password and PIN code

Q .64Q .64 Whic h of the fo l lowing is  the c orrec t  option for  c reat ing a page border  that  appears  on s pec ific  pages  only ,  s uc h asWhic h of the fo l lowing is  the c orrec t  option for  c reat ing a page border  that  appears  on s pec ific  pages  only ,  s uc h as
the firs t  page or  a  s ec t ion’s  firs t  page?the firs t  page or  a  s ec t ion’s  firs t  page?

A nsA ns 1. Use the Page Borders feature under the Design tab, then specify options in the Apply To menu.

2. Apply borders manually to text boxes on the desired pages.

3. Use the Page Layout tab to apply a border and specify pages.

4. Use the Design tab, then Borders and apply to the specific pages.

Q .65Q .65 Whic h key board s hortc ut c opies  the formatt ing of the s elec ted text?Whic h key board s hortc ut c opies  the formatt ing of the s elec ted text?

A nsA ns 1. Ctrl + C + F

2. Ctrl + Shift + C

3. Ctrl + Alt + C

4. Ctrl + C

Section : Basic Knowledge of Computer

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap


Q .66Q .66

A nsA ns 1. 

2. 

3. 

4. 

Q .67Q .67 How c an s martphones  be s ec ured?How c an s martphones  be s ec ured?

A nsA ns 1. By not using VPN

2. By not connecting to secure Wi-Fi

3. By keeping Bluetooth off

4. By downloading software from untrusted sources

Q .68Q .68 Whic h of the fo l lowing is  NO T an email  c l ient?Whic h of the fo l lowing is  NO T an email  c l ient?

A nsA ns 1. Apple Mail

2. Firefox

3. Gmail

4. Microsoft Outlook

Q .69Q .69 Whic h ac t ion would  one take to  ens ure that  a  forwarded email  thread remains  pr ivate and does  NO T s how theWhic h ac t ion would  one take to  ens ure that  a  forwarded email  thread remains  pr ivate and does  NO T s how the
email  addres s es  of previous  rec ipients  in a  webmail  c l ient?email  addres s es  of previous  rec ipients  in a  webmail  c l ient?

A nsA ns 1. Use the 'Reply All' function

2. Manually delete previous recipient information from the forwarded email

3. Use the 'BCC' field for new recipients

4. Change the email service provider

Q .70Q .70 Whic h of the fo l lowing prac t ices  is  es s entia l  for  enhanc ing appl ic at ion s ec ur ity ?Whic h of the fo l lowing prac t ices  is  es s entia l  for  enhanc ing appl ic at ion s ec ur ity ?

A nsA ns 1. Sharing passwords with team members for collaborative work

2. Regularly updating software and applying security patches

3. Ignoring security warnings and pop-ups during software installation

4. Disabling antivirus software to avoid performance issues

Q .71Q .71 When adding a C l ipA rt  pic ture to  a  PowerPoint  s l ide in an M S  PowerPoint ,  2 0 1 9 ,  pres entat ion,  whic h of theWhen adding a C l ipA rt  pic ture to  a  PowerPoint  s l ide in an M S  PowerPoint ,  2 0 1 9 ,  pres entat ion,  whic h of the
fo l lowing s teps  is  c orrec t  for  finding and ins ert ing the des ired image?fo l lowing s teps  is  c orrec t  for  finding and ins ert ing the des ired image?

A nsA ns 1. Go to the 'Home' tab, select 'Insert Picture', then select 'ClipArt' from the options.

2. Go to the 'Design' tab and select 'ClipArt' to browse and insert pictures.

3. Go to the 'Insert' tab, select 'Pictures', then select 'Online Pictures' and search for ClipArt.

4. Go to the 'Slide Show' tab, select 'Add Picture' and then select 'ClipArt'.

Q .72Q .72 Whic h vers ion of Windows  introduced the S tart  M enu?Whic h vers ion of Windows  introduced the S tart  M enu?

A nsA ns 1. Windows 95

2. Windows 3.1

3. Windows 7

4. Windows XP

Q .73Q .73 Whic h of the fo l lowing options  is  NO T pres ent whi le c reat ing a new doc ument us ing onl ine templates  in M S  Word?Whic h of the fo l lowing options  is  NO T pres ent whi le c reat ing a new doc ument us ing onl ine templates  in M S  Word?

A nsA ns 1. Flyers

2. Business

3. Conference

4. Cards
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Q .74Q .74 What is  the pr imary  purpos e of the 'BCC '  field  in an email?What is  the pr imary  purpos e of the 'BCC '  field  in an email?

A nsA ns 1. To send a copy of the email to the sender

2. To block the email address of the recipient

3. To send a copy of the email to all recipients visible to each other

4. To send a blind carbon copy to recipients without revealing their email addresses to others

Q .75Q .75

A nsA ns 1. 

2. 

3. 

4. 

Q .76Q .76

A nsA ns 1. 

2. 

3. 

4. 

Q .77Q .77 What is  the maximum number of items  that  the O ffice C l ipboard c an s tore?What is  the maximum number of items  that  the O ffice C l ipboard c an s tore?

A nsA ns 1. 50 items

2. 24 items

3. 10 items

4. Unlimited

Q .78Q .78 Whic h al ignment option in M S  Word al igns  text  evenly  s paced ac ros s  both the left  and r ight  margins?Whic h al ignment option in M S  Word al igns  text  evenly  s paced ac ros s  both the left  and r ight  margins?

A nsA ns 1. Justified

2. Left

3. Center

4. Right

Q .79Q .79 Whic h of the fo l lowing key board s hortc uts  c an be us ed to  add a new blank  s l ide after  the c urrent s l ide in anWhic h of the fo l lowing key board s hortc uts  c an be us ed to  add a new blank  s l ide after  the c urrent s l ide in an
exis t ing M S  PowerPoint  pres entat ion?exis t ing M S  PowerPoint  pres entat ion?

A nsA ns 1. Ctrl + S

2. Ctrl + P

3. Ctrl + A

4. Ctrl + M

Q .80Q .80 What is  the res ult  of  the fo l lowing func t ion in M S  E xcel  2 0 1 0 ?What is  the res ult  of  the fo l lowing func t ion in M S  E xcel  2 0 1 0 ?

=S UM ( A ,  1 ,  2 ,  3 )=S UM ( A ,  1 ,  2 ,  3 )

A nsA ns 1. 6

2. #NAME?

3. 16

4. #VALUE!

Section : Quantitative Aptitude
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Q .81Q .81 A  s hopkeeper  l is ts  the pr ice of a  fan at  4 0 % above its  c os t  pr ice and offers  a  2 0 % dis c ount on its  l is t  pr ice.  I f  heA  s hopkeeper  l is ts  the pr ice of a  fan at  4 0 % above its  c os t  pr ice and offers  a  2 0 % dis c ount on its  l is t  pr ice.  I f  he
earns  a  profit of ₹1 4 4 ,  then what is  the l is t  pr ice ( in ₹)  of  the fan?earns  a  profit of ₹1 4 4 ,  then what is  the l is t  pr ice ( in ₹)  of  the fan?

A nsA ns 1. 1,883

2. 1,680

3. 1,896

4. 1,822

Q .82Q .82 A n item is  marked 1 75% higher  than its  c os t  pr ice.  E ven after  a l lowing s ome d is c ount ,  the s hopkeeper  earned 1 0 %A n item is  marked 1 75% higher  than its  c os t  pr ice.  E ven after  a l lowing s ome d is c ount ,  the s hopkeeper  earned 1 0 %
profit .  F ind the d is c ount percentage al lowed by  the s hopkeeper.profit .  F ind the d is c ount percentage al lowed by  the s hopkeeper.

A nsA ns 1. 61%

2. 63%

3. 60%

4. 57%

Q .83Q .83 A  s hopkeeper  offers  a  d is c ount of 2 0 % on an art ic le and he s t i l l  makes  a  profit of 1 0 %.  What is  the c os t  pr iceA  s hopkeeper  offers  a  d is c ount of 2 0 % on an art ic le and he s t i l l  makes  a  profit of 1 0 %.  What is  the c os t  pr ice
( rounded off to  the neares t  integer)  of  the art ic le with a  marked pr ice of ₹80 0 ?( rounded off to  the neares t  integer)  of  the art ic le with a  marked pr ice of ₹80 0 ?

A nsA ns 1. ₹582

2. ₹640

3. ₹682

4. ₹540

Q .84Q .84 The or iginal  pr ice of a  mus ic  s et  is  ₹8 ,1 0 0 .  The pr ice is  d is c ounted by  2 0 % and then rais ed by  2 0 %.  What is  its  newThe or iginal  pr ice of a  mus ic  s et  is  ₹8 ,1 0 0 .  The pr ice is  d is c ounted by  2 0 % and then rais ed by  2 0 %.  What is  its  new
price ( in ₹) ?pr ice ( in ₹) ?

A nsA ns 1. 8,276

2. 7,076

3. 7,776

4. 7,276

Q .85Q .85

A nsA ns 1. 
            

2 . 

3. 
           

4. 
           

QQ
..
88
66

AA
nn
ss

1. 

2. 

3. 

4. 
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Q .87Q .87 The rat io  of  the pres ent ages  of Pr iy a and Rahul  is  7  :  5,  and the s um of their  pres ent ages  is  72  y ears .  What isThe rat io  of  the pres ent ages  of Pr iy a and Rahul  is  7  :  5,  and the s um of their  pres ent ages  is  72  y ears .  What is
Rahul 's  pres ent age?Rahul 's  pres ent age?

A nsA ns 1. 32 years

2. 25 years

3. 20 years

4. 30 years

Q .88Q .88 The s alary  of  a  worker  is  firs t  inc reas ed by  3 2 %.  Thereafter,  it  was  reduced by  t%;  the net  c hange in his  s alary  isThe s alary  of  a  worker  is  firs t  inc reas ed by  3 2 %.  Thereafter,  it  was  reduced by  t%;  the net  c hange in his  s alary  is
1 8 .8%.  What is  the value of t?1 8 .8%.  What is  the value of t?

A nsA ns 1. 9%

2. 8%

3. 7%

4. 10%

Q .89Q .89 The average of a  bats man in 2 2  innings  is  4 6 runs .  In the next  innings ,  he s c ored 4 6 runs .  What wi l l  be his  newThe average of a  bats man in 2 2  innings  is  4 6 runs .  In the next  innings ,  he s c ored 4 6 runs .  What wi l l  be his  new
average ( in runs) ?average ( in runs) ?

A nsA ns 1. 50

2. 46

3. 54

4. 58

Q .90Q .90 A  reduc tion of 2 0 % in the pr ice of s ugar  enables  a  hous ewife to  buy  4  kg more for  ₹1 ,80 0 .  The reduced pr ice ofA  reduc t ion of 2 0 % in the pr ice of s ugar  enables  a  hous ewife to  buy  4  kg more for  ₹1 ,80 0 .  The reduced pr ice of
s ugar  per  kg is :s ugar  per  kg is :

A nsA ns 1. ₹100.5

2. ₹110

3. ₹90

4. ₹95.5

Q .91Q .91 The average of 6 . 5,  1 0 .6 ,  1 9 .7  and a is  1 5.  The value of a  is :The average of 6 . 5,  1 0 .6 ,  1 9 .7  and a is  1 5.  The value of a  is :

A nsA ns 1. 24.2

2. 25.2

3. 23.2

4. 22.2

Q .92Q .92 A  pers on s aves  60 % of his  inc ome.  I f  his  expenditure is  ₹60 0 ,  then his  inc ome ( in ₹)  is :A  pers on s aves  60 % of his  inc ome.  I f  his  expenditure is  ₹60 0 ,  then his  inc ome ( in ₹)  is :

A nsA ns 1. 700

2. 840

3. 1,540

4. 1,500

Q .93Q .93 A  s hip goes  at  a  s peed of 1 9  km/ hr  downs tream and at  a  s peed of 1 5 km/ hr  ups tream.  What wi l l  be the s peed of theA  s hip goes  at  a  s peed of 1 9  km/ hr  downs tream and at  a  s peed of 1 5 km/ hr  ups tream.  What wi l l  be the s peed of the
s hip in s t i l l  water?s hip in s t i l l  water?

A nsA ns 1. 16 km/hr

2. 14 km/hr

3. 15 km/hr

4. 17 km/hr
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Q .94Q .94 Three taps ,  A ,  B  and C ,  when opened together,  c an fil l  a  c is tern in 5 hours .  I f  the s peed of C  is  double that  of  B  andThree taps ,  A ,  B  and C ,  when opened together,  c an fil l  a  c is tern in 5 hours .  I f  the s peed of C  is  double that  of  B  and
the s peed of B  is  double that  of  A ,  then how muc h t ime wi l l  A  a lone take to  fil l  the empty  c is tern?the s peed of B  is  double that  of  A ,  then how muc h t ime wi l l  A  a lone take to  fil l  the empty  c is tern?

A nsA ns 1. 35 hours

2. 36 hours

3. 34 hours

4. 33 hours

Q .95Q .95 How many  d igits  are there in the s quare root  of 9860 4 9?How many  d igits  are there in the s quare root  of 9860 4 9?

A nsA ns 1. 5

2. 6

3. 4

4. 3

Q .96Q .96 In 1 998 ,  Paroma was  6 .2 5 t imes  as  o ld  as  her  niece,  S eema.  In 2 0 0 1 ,  Paroma was  four  t imes  as  o ld  as  S eema.  InIn 1 998 ,  Paroma was  6 .2 5 t imes  as  o ld  as  her  niece,  S eema.  In 2 0 0 1 ,  Paroma was  four  t imes  as  o ld  as  S eema.  In
whic h y ear  was  the age of S eema only  4 0 % of that  of  Paroma?whic h y ear  was  the age of S eema only  4 0 % of that  of  Paroma?

A nsA ns 1. 2006

2. 2007

3. 2009

4. 2008

Q .97Q .97 Two c andidates  c ontes ted an elec t ion.  The winning c andidate s c ored 64% of the val id  votes  and won by  1 ,1 2 ,0 0 0Two c andidates  c ontes ted an elec t ion.  The winning c andidate s c ored 64% of the val id  votes  and won by  1 ,1 2 ,0 0 0
votes .  I f  58 ,0 0 0  votes  were dec lared inval id ,  then find the total  number of votes  pol led  in the elec t ion.votes .  I f  58 ,0 0 0  votes  were dec lared inval id ,  then find the total  number of votes  pol led  in the elec t ion.

A nsA ns 1. 4,85,000

2. 4,80,500

3. 4,58,000

4. 4,50,800

Q .98Q .98 E valuate:  1 850  − [ 4 50  − { 2 1 0  − ( 90  − 80  − 1 0 ) } ]E valuate:  1 850  − [ 4 50  − { 2 1 0  − ( 90  − 80  − 1 0 ) } ]

A nsA ns 1. 1685

2. 1610

3. 1470

4. 1540

Q .99Q .99

A nsA ns 1. 

2. 

            

3. 

           

4. 
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Q .1 0 0Q .1 0 0 S uraj  c overs  72 6 km in a  boat  in 4 5 hours  agains t  the s tream and he takes  1 8  hours  with the s tream.  Find theS uraj  c overs  72 6 km in a  boat  in 4 5 hours  agains t  the s tream and he takes  1 8  hours  with the s tream.  Find the
approximate s peed of the s tream.approximate s peed of the s tream.

A nsA ns 1. 10.93 km/hr

2. 12.1 km/hr

3. 10.28 km/hr

4. 21.25 km/hr
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